Trademarks
Any other brand or product names are trademarks or registered trademarks of their respective holders.

The Genesis Group Trademark Information
GenWatch3® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks.

Copyright
Copyright © 2006-2020; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A: The Genesis Group and Phil Burks
5800 Eagles Nest Blvd
Tyler, Texas 75703.
Includes technology licensed from Motorola.

Disclaimer
The GenWatch3 User’s Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does not assume responsibility to notify any person of such revisions or changes. While we have taken strides to carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks assume no responsibility for the use of the manual, or GenWatch3 software, nor for any patent infringements or other rights of third parties who may use the manual or the GenWatch3 software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid by the end-user.

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed these statements.

License
Title to the media on which the program is recorded and to the documentation in support of the product is transferred to you, but title to the program, and all subsequent copies of the program, despite the form or media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the selection of the program to achieve your intended results, and for the installation, use, and results obtained from the program.

Refer to the GenWatch3 Manual Overview for your full license. All license information contained on pages 4-7 (Book 600-2.16.15-AA.1) are to be considered as contained herein.

Support
Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best software possible, and we want to know when you have any questions, concerns or problems with GenWatch3 so that we can make it a better product for everyone.

Refer to the Troubleshooting & Support section of the GenWatch3 Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
## Document History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.2</td>
<td>Initial Release</td>
<td></td>
</tr>
<tr>
<td>2.0.3</td>
<td>Updated Screenshots</td>
<td>CBH</td>
</tr>
<tr>
<td>2.0.3</td>
<td>Revision Before Release</td>
<td>CBH</td>
</tr>
<tr>
<td>2.0.4</td>
<td>Revision Before Release</td>
<td>CBH</td>
</tr>
<tr>
<td>2.0.4</td>
<td>Updated Images</td>
<td>KIH</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Revision before release</td>
<td>TDW</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated screenshots</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Console Window</td>
<td>KIH</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated screenshots</td>
<td>CLB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Added description of multislots functionality</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated Console Window screenshot</td>
<td>CLB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated Options section</td>
<td>WRK</td>
</tr>
<tr>
<td>2.0.6.6</td>
<td>Revision Before Release</td>
<td>KIH</td>
</tr>
<tr>
<td>2.3</td>
<td>Revision Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.4</td>
<td>Revision Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Revision Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Statistics window screenshot with Slots</td>
<td>REB</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Systems Panel Section</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Statistics with Airtime Information</td>
<td>KIH</td>
</tr>
<tr>
<td>2.6</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.8</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.9</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.9</td>
<td>Removed obsolete note about Offline channels.</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.11</td>
<td>Converted to Docx format</td>
<td>CWF</td>
</tr>
<tr>
<td>2.12</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.13</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.14</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.15</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.15</td>
<td>Added Dimetra control channel utilization.</td>
<td>REB</td>
</tr>
<tr>
<td>2.16</td>
<td>Revisions Before Release</td>
<td>KIH</td>
</tr>
</tbody>
</table>
# Table of Contents

- Trademarks .................................................................................. 3
- The Genesis Group Trademark Information ....................................... 3
- Copyright ..................................................................................... 3
- Disclaimer .................................................................................... 3
- License ........................................................................................ 3
- Support ....................................................................................... 3

**DOCUMENT HISTORY** ...................................................................... 4

## TABLE OF CONTENTS ........................................................................... 5

## ABOUT THIS MANUAL ......................................................................... 7

- GOALS ......................................................................................... 7
- WHO SHOULD READ THIS MANUAL? ............................................... 7
- HOW THIS MANUAL IS ORGANIZED ............................................... 7

## CHAPTER 1 OVERVIEW ......................................................................... 9

- WHAT IS GW_CHANNEL? .................................................................... 9

## CHAPTER 2 USING GW_CHANNEL ..................................................... 11

- POSITIONING CHANNELS ............................................................... 11
- UNDERSTANDING CHANNEL STATUS DATA ................................... 12
  - Information Pane ........................................................................ 12
  - Systems Panel Data ..................................................................... 13
  - Reject Reason Information ......................................................... 14
  - Diagnostics Panel Data ............................................................... 15
  - Buses Panel Data ....................................................................... 16
  - Color Legend ............................................................................. 17
  - Sounds Button ........................................................................... 18
  - Menus ....................................................................................... 19
  - View ......................................................................................... 19
  - Edit .......................................................................................... 19
  - Help ........................................................................................ 20
- GW_Channel Options ....................................................................... 21

## SYSTEM ACTIVITY VIEW ..................................................................... 25

- System Header ................................................................................ 25
  - RFSSs Menu ............................................................................ 25
  - Sites Menu .............................................................................. 25
- RFSS Header .................................................................................. 26
  - Sites Menu .............................................................................. 26
- Site Header .................................................................................... 27
- Statistics ...................................................................................... 28
- Adjacent Sites ................................................................................ 30
- Site Idle Interval ........................................................................... 31
- Channel Activity ............................................................................ 32
  - Radio Commands ..................................................................... 32
  - Slotted Activity ......................................................................... 33
  - Systems with large numbers of channels .................................. 34
  - Duplex Activity ......................................................................... 34
  - Analog and Digital Activity ....................................................... 34
  - Dimetra Channel Capabilities .................................................... 34
  - Dimetra Control Channel Utilization ......................................... 35
  - APM Data Supplementation ....................................................... 35
  - Packet Information Window ...................................................... 36
- Threshold Lights ............................................................................. 38
  - Example Thresholds ................................................................... 38
Threshold Alert panel........................................................................................................................................... 39

*Console Window* ............................................................................................................................................. 40

Gold Elite Consoles ........................................................................................................................................... 40

Vortex Consoles.................................................................................................................................................. 40
About this Manual

**Goals**
This manual describes the role and function of the GW_Channel module and graphical user interface (GUI) in the GenWatch3 solution.

**Who Should Read This Manual?**
This manual is written for an intended audience of novice to mid-level trunked system users and novice to mid-level PC users.

**How This Manual Is Organized**
This manual is organized as follows:

- **Overview**: Defines the GW_Channel GUI and the organization of the channel information.
- **Using GW_Channel**: provides instructions on reading the GW_Channel data and setting up the GUI to satisfy your viewing needs.

This manual contains the following images, used to indicate that a segment of text requires special attention:

- **Additional Information**: Additional information is used to indicate shortcuts or tips.
- **Warning**: Warnings are used to indicate possible problem areas, such as a risk of data loss, or incorrect/unexpected functionality.
Chapter 1

Overview

This chapter defines the GW_Channel GUI and the organization of the channel information.

This chapter contains the following sections:

- **What is GW_Channel?**: Defines the GW_Channel GUI.

**What is GW_Channel?**

The GW_Channel GUI displays real-time, decoded channel activity, diagnostics, busies and rejects. The GW_Channel GUI displays activity for each channel on individual virtual repeater channel blocks. The diagnostics, busies and reject reasons are shown in their own respective lists on the left side of the GUI.

*This GUI’s information is volatile. This means that if you close this GUI, GW_Channel will not save the information in the Diagnostics, Busies and Reject Reasons lists or any information in the channel monitors.*

*GW_Channel resources, such as systems, RFSSs, sites and channels, reflect the changes made to these resources in GW_Alias. For example, if you change a site’s alias in GW_Alias, GW_Channel will reflect this change. These changes may take up to 30 seconds to take effect in the Channel GUI.*

![Figure 1.1 – GW_Channel GUI](image-url)
Chapter 2 Using GW_Channel

This chapter provides instructions on understanding the GW_Channel data and setting up the GUI to satisfy your viewing needs.

This chapter contains the following sections:

- **Positioning Channels**: Describes how to position channels within a site.
- **Understanding Channel Status Data**: Describes each type of data displayed in the GW_Channel GUI.
- **System Activity View**: Describes each section of the real-time system, RFSS, site and channel-based display.

### Positioning Channels

This section references setup processes in the GW_Alias GUI. Please refer to the *GW_Alias Module Book* for instructions on using the GW_Alias GUI.

The GW_Channel GUI works best when all of a system’s channels exist in the GW_Alias module.

![Site Options](image)

**Figure 2.1** – Dynamically Add Channel Option in GW_Alias GUI

By default, the channels in the GW_Channel GUI will display in order of the channel’s key type (frequency or position). The channel’s key type is determined by the **Channel Key Type** of the channel’s site.

The **Use Channel Aliases in Header** option in the GW_Channel GUI allows you to choose to sort these channels by the channel’s alias instead (see the *GW_Channel Options* section of this document for more details).
Three common patterns you can use to optimally display channels in the GW_Channel GUI are:

- **Position based**: On a system with 11 channels, the primary control channel could be assigned alias 01 and the least active dispatch activity channel could be assigned alias 11. The first position needs to have a leading zero because alias sorting would put 11 before 2.

- **Frequency based**: To sort by frequency set the alias to the frequency number of each channel. Frequencies are generally the same length and will not have to be padded with zero values.

- **Position and Frequency based**: To sort by Position and frequency set the alias in the following format xx yyyyyyyyy where xx is the position and yyyyyyyyy is the frequency.

### Understanding Channel Status Data

The GW_Channel GUI displays a vast amount of information. This information is organized and displayed in the following areas:

- **Information Pane**: Shows the currently selected system and any radio rejects, diagnostics, and busies.

- **Activity Panel**: Shows site-based channel blocks when a site is checked in the Systems Panel.

### Information Pane

The Information Pane contains multiple panels that may be resized or collapsed as desired. In addition to these panels, the Information Pane also contains the Sounds button.

- **Systems Panel**: Shows each system, RFSS and site that currently exists in the GW_Alias database.

- **Radio Reject / Diagnostics**: Shows real-time radio reject or diagnostic information as it is received.

- **Busies Panel**: Shows real-time busy activity as it occurs.
Systems Panel Data

The Systems panel (Figure 2.2) shows the tree of known system resources that pertain to the channel hierarchy. In this hierarchy:

- RFSSs exist under systems.
- Sites exist under RFSSs.
- Channels exist under sites.

This tree structure displays this hierarchy down to the site level. To display channels on a site, check the box next to the site in the Systems panel’s resource tree. To view this activity at the RFSS level, check the box next to an RFSS.

![Figure 2.2 – Systems Panel Resource Tree](image)

The checkboxes beside the parent structures in the tree for RFSSs and sites can be checked or unchecked to select all the subitems (RFSSs and sites). The checkbox next to the Systems node is used to expand or collapse all subitems (systems, RFSSs and sites). The checkbox next to the system (WACN:System) is used to select the system you wish to view in the Activity panel.
Reject Reason Information

The Radio Rejects button is near the middle-left of the GW_Channel GUI. Click this button to show radio rejects on this section of the window (Figure 2.3). The reject reasons list shows each reject reason that has appeared on the control channel since the GW_Channel GUI was opened. Each reject reason in the list contains the following information:

- **System**: The WACN and system on which the rejection occurred.
- **RFSS**: The RFSS on which the rejection occurred.
- **Site**: The site on which the rejection occurred.
- **Talkgroup**: The talkgroup on which the rejection occurred.
- **ID**: The ID that was rejected.
- **Reason**: The reported reason the rejection occurred.
- **Rejectee**: Identifies what was rejected. Can be one of the following:
  - Source
  - Target
  - Patch
- **Timestamp**: The last date and time the rejection occurred.
- **Count**: The number of times this rejection has occurred.

![Radio Rejects List](image)

**Figure 2.3** – Radio Rejects List

Right-clicking on the Radio Rejects panel will cause a context menu to be shown, with options to print the rejects or clear selected rejects.
Diagnostics Panel Data

The **Diagnostics** button is near the middle of the GW_Channel GUI. Click this button to show diagnostics on this section of the GUI (Figure 2.4). The *Diagnostics* list shows each diagnostic that has appeared on the control channel since the GW_Channel GUI was opened. New diagnostics will be displayed with red text until they are cleared. Each diagnostic in the list contains the following information:

- **System**: The WACN and system on which the diagnostic occurred.
- **RFSS**: The RFSS on which the diagnostic occurred.
- **Site**: The site on which the diagnostic occurred.
- **Device**: The device, such as a board or control, within the controller that reported the diagnostic.
- **Position**: The channel position on which the diagnostic occurred.
- **Condition**: The condition of the reported device.
- **Timestamp**: The date and time this diagnostic was received.
- **Hardware**: System type.
- **Count**: The number of times this diagnostic packet was received.

![Figure 2.4 – Diagnostics List](image)

Right-clicking on the *Diagnostics* panel will cause a context menu to be shown with the following options:

- **Print Diagnostics**: Prints diagnostics.
- **Purge Selected Diagnostics**: Removes the selected diagnostics from the panel.
Busies Panel Data

Busy packets are displayed in the *Busies* panel (Figure 2.5) as they are received over the control channel. The following information is shown for each received packet:

- **System**: WACN and system on which the call occurred.
- **RFSS**: RFSS on which the call occurred.
- **Site**: Site on which the call occurred. This column will show *Interzone* if the site ID is unknown (interzone or console busies).
- **E**: This column contains a flag indicating if the call was an emergency. If this was an emergency busy, this value will be 1. Otherwise, it will be 0.
- **ID**: Radio ID that initiated the busy call.
- **Talkgroup**: Group, if any, on which the busy call took place.
- **Call Type**: Call type of the busy call. This can be one of the following:
  - Group
  - Private
  - Interconnect
  - Radio Data
- **Start Time**: Date and time the call started.
- **End Time**: Date and time the call ended.
- **Elapsed Time (ms)**: Duration of the call.
- **Coded**: Flag indicating if the call was coded.
- **Digital**: Flag indicating if the call was digital.
- **Patch**: Flag indicating if the call was patch.
- **Multigroup**: Flag indicating if the call was multigroup.
- **Multiselect**: Flag indicating if the call was multiselect.
- **System Wide**: Flag indicating if the call was system wide.

![Busies Panel and Options Menu](image)

*Figure 2.5 – GW_Channel Busies Panel and Options Menu*
Busy calls are shown in the *Busies* panel only if GW_Alias is aware of the system, RFSS and site on which the busy is occurring. For example, if an RFSS is not listed in the resource tree in GW_Alias, busies occurring in that RFSS will not be listed in GW_Channel. See the *GW_Alias Module Book* for information on how to enable the dynamic adding of RFSSs and sites. The dynamic adding of resources will allow all busies for the currently selected system to be listed in GW_Channel.

While a busy call is in the system’s busy queue, it will show as a red entry in the list. Once the entry leaves the queue, it will become gray if it was a partial busy and black if it was a global busy. The *Active Busies* at the bottom of GW_Channel will be shown in red when there are active busies and black otherwise.

The *Busies* panel can contain a maximum of 1,000 active and completed busy entries. The number of completed busies displayed can be reduced with the slider in the *Busy Panel Options Menu*. Reducing the slider to the minimum value will remove all completed busies and only show active busies.

When the busy list is at maximum capacity, the oldest entries are removed as new busies occur. Busies can also be removed manually or automatically (based on time) by checking the *Remove Busies* option in the *Busy Panel Options Menu* (Figure 2.5). When this feature is enabled, busies will be removed automatically from the busy list after the duration specified by the slider.

Right-clicking on the *Busies* panel will cause a context menu to be shown, with options to print the busies or clear selected busies.

**Color Legend**

The *Color Legend* window (Figure 2.6) shows the current color settings as configured via the *Edit→Colors* menu discussed later in this document. This window is accessed from the *View* menu.

![Color Legend](image)

*Figure 2.6 – Color Legend*

Conventional calls are colored the same as Group calls.
Sounds Button

Click this button to toggle sounds on or off as desired (Figure 2.7).

<table>
<thead>
<tr>
<th>Busy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
</tr>
<tr>
<td>Site Idle</td>
</tr>
</tbody>
</table>

**Figure 2.7 – Sound Options menu**

There are three available sounds:

- **Busy**: plays whenever a busy call occurs
- **Emergency**: plays whenever an emergency call occurs
- **Site Idle**: plays whenever a site has not had activity for longer than the number of seconds that is set as its idle interval
Menus

View

- **Information Pane:** Toggle visibility of the *Information Pane* on the left side of the GW_Channel GUI.
- **Use Alias Colors:** Channel activity information displayed within each channel can be shown using the colors selected in the GW_Alias GUI for radio IDs and talkgroups, as shown in Figure 2.8.
- **Color Legend:** Toggle visibility of the *Color Legend* window.

![Figure 2.8 – Channel activity shown with the colors specified in GW_Alias.](image)

Edit

- **Global Site Idle Interval:** Determines how long the GW_Channel GUI should wait to provide a visual indication that a site is idle (no activity has occurred for $x$ amount of time) for all sites.
- **Enhancements:** Customizes or optimizes the behavior and appearance of channels. These options can be checked (enabled) or unchecked (disabled) and are global preferences, saved per user session.
  - **Add Expected Channels:** Upon receiving activity on a channel, all channel blocks with a lower position number that have not already reported activity will be automatically added. (This feature only applies to data received from position-based data sources)
  - **Variable Channel Heights:** Allows channel blocks to vary in height based on the call information the user has selected to be shown.
- **Options:** Displays the *Channel Options* window. See the next section for more information.
- **Colors:** Allows for modification of the foreground and background colors of each activity type (Figure 2.9).
Figure 2.9 – Channel Color Configuration

Help
- **Show Help**: Displays the Help document for GW_Channel.
- **About**: Displays information about GW_Channel.
GW_Channel Options

Options are used to further customize how Channel is used. The GW_Channel Options window can be accessed by navigating to Edit → Options.

![GW_Channel Options Window]

Figure 2.10 – General Options

There are several different sections in the GW_Channel Options window that can be accessed by clicking on the appropriate section on the left side of the window. The first section that shows up is the General Options section. The following options are available here:

- **General Options**: Visibility options that apply to the GW_Channel GUI.
  - **Show Information Pane**: Toggle visibility of the Information Pane on the left side of the GW_Channel GUI.
  - **Auto-Jump to Active Emergency**: Toggle feature for Channel to jump to the site on the current system that has an active emergency.
  - **Show Partial Busies in Busy List**: Toggle display of Partial Busies in the Busy List. Partial Busies are Busy occurrences where the call request could not acquire at least one channel on one of the sites targeted by the call.

- **Shortcuts**: Allows you to assign an option that can be toggled to a function key. (The function keys are the F1-F12 keys that are at the top of the keyboard.)
  - **Toggle Info Pane Visibility**: Toggles the Show Information Pane option with the designated key.
o **Toggle Color Legend Visibility**: Toggles the visibility of the Color Legend window with the designated key.

o **Toggle Threshold Panel Visibility**: Toggles the visibility of the Threshold panel with the designated key. (The Threshold panel is the pop-up window in the bottom-right corner with the flashing red, amber and green lights.)

o **Toggle Busy Pane**: Toggles the visibility of the Busy panel near the bottom of the Information Pane.

o **Toggle Diag Reject Pane**: Toggles the visibility of the Radio Rejects / Diagnostics panel in the Information Pane.

o **Toggle Systems Pane**: Toggles the visibility of the Systems panel in the Information Pane.

The second section is the Activity Area options. This section controls options for the main portion of the window that contains the system, RFSS, site and individual channel information. There are individual option sections that allow for modification of options that apply specifically to these subsections. The Activity Area node has the following options:

- **Add Expected Channels**: Upon receiving activity on a channel, all channel blocks with a lower position number that have not already reported activity will be automatically added. (This feature only applies to data received from position-based data sources).

- **Variable Channel Heights**: Allows channel blocks to vary in height based on the call information the user has selected to be shown.

**RFSS Options:**

- **Show RFSS id/alias label**: Show the id/alias label of each RFSS in the RFSS Header.

- **Show active resource (channel/slot) count**: Show the number of active resources (channels or slots) present on the RFSS in the RFSS Header.

- **Show active busy count**: Show the count of active busies occurring on this RFSS in the RFSS Header.

- **Show last activity timestamp**: Show the timestamp of the last call activity that occurred on this RFSS in the RFSS Header.
Figure 2.11 – RFSS Options

**Site Options:**
- **Show site id/alias label:** Show the ID/alias label of each site in the Site Header.
- **Show active resource (channel/slot) count:** Show the number of active resources (channels or slots) present on the site in the Site Header.
- **Show active busy count:** Show the number of active busies on the site in the Site Header.
- **Show last activity timestamp:** Show the timestamp of the last call activity that occurred on the site in the Site Header.
- **Show busy duration:** Show the duration of busies that occurred on the site in the Site Header.

**Channel Options:**
- **Use colors from GW_Alias:** Use the colors that are defined in the GW_Alias module in the presentation of channels.
- **Use channel alias in header:** Displays the alias for the channel instead of the channel number or frequency. This will cause channels to be sorted by their aliases.
- **Control Channel Utilization [Dimetra Only]**
  - Defines if and how the control channel load percentage contained in Site Monitor Update packets are shown in the lower-right corner of a control channel.
  - **Show Control Channel Utilization:** Shows the control channel utilization block.
- High Threshold (Red background): The control channel utilization block will have its background colored red whenever the utilization is at or above the specified percentage.

- Mid Threshold (Orange background): The control channel utilization block will have its background colored orange whenever the utilization is at or above the specified percentage and below the High Threshold.

- Low Threshold (Green background): The control channel utilization block will have its background colored green whenever the utilization is below the Mid Threshold.
**System Activity View**

To show the system activity view, check the box next to a system in the *Systems Panel*. This will open the system activity view for that system. The system activity view is made of the following parts:

### System Header

The *System Header* (Figure 2.12) shows the following system-level information:

- **WACN:** *System ID*: WACN and System ID.
- **System Alias**: Alias of the system.
- **RFSSs**: Adjust settings for all RFSSs in the system.
- **Sites**: Adjust settings for all sites in the system.
- **Last Activity**: Date and time of the last call activity received by the system. This value is based on the system clock, not the packet timestamp.

![Figure 2.12 – System Header](image)

### RFSSs Menu

The *RFSSs* menu on the *System Header* contains the following options:

- **View**: Allows selection of the summary/detail and wrapped/unwrapped options for all RFSSs within the system.

### Sites Menu

The *Sites* menu on the *System Header* contains the following options:

- **Hide All**: Hide all channel displays of all sites within the system.
- **Show All**: Show all channel displays of all sites within the system.
- **Sort**: Allows for ascending or descending sorting of sites by number or alias.
- **Font**: Allows for modification of the font used throughout the system.
- **Call Info**: Allows for selection of information to display about activity in all channels within the system.
- **Width**: Allows for modification of all channel widths within the system.
- **Idle Timer**: Allows for setting the idle interval of all sites within the system.

The following options on the *Sites* menu may be disabled when conflicting settings are detected in one or more RFSSs within a system: *Hide All, Show All, Font, Call Info*. Changing the summary view settings on one or more RFSSs may allow use of these options on the *System Header*. 

---

25

600-2.16.15-1.1
RFSS Header

The RFSS Header (Figure 2.13) shows the following RFSS-level information:

- **Hide/Show**: Allows the RFSS activity area under the RFSS Header to be hidden or shown.
- **RFSS ID**: ID of the RFSS.
- **RFSS Alias**: Alias of the RFSS.
- **Sites**: Site-based options menu.
- **Wrap**
  - **On**: Channels/Sites are shown using as many rows as necessary to avoid the use of horizontal scrollbars.
  - **Off**: Channels/Sites are shown on a single row with horizontal scrollbars used as needed.
- **Summary**
  - **On**: Summarizes all channels in all sites under an RFSS by showing channels (without call info) on sites with an adjustable width.
  - **Off**: Shows all channels (with the selected call info) on sites which span the entire width of the RFSS Activity Area.
- **Consoles**: Launches the console window for this RFSS.
- **Active Busies**: Number of active busies in this RFSS. Each site on which a radio is busy will be counted toward this total.
- **Active Resources**: Number of active resources in this RFSS.
- **Last Activity**: Date and time of the last call activity received by this RFSS. This value is based on the system clock, not the packet timestamp.

![RFSS Header Screenshot](image)

**Figure 2.13** – RFSS Header

Sites Menu

The Sites menu on the RFSS Header contains the following options:

- **Hide All**: Hide all channel displays of all sites within this RFSS.
- **Show All**: Show all channel displays of all sites within this RFSS.
- **Sort**: Allows for ascending or descending sorting of sites by number or alias.
- **Font**: Allows for modification of the font used on channels within this RFSS.
- **Call Info**: Allows for selection of what information to display about activity in all channels within this RFSS.
- **Width**: Allows for modification of all channel widths within the RFSS.
- **Idle Timer**: Allows for setting the idle interval of all sites within this RFSS.
The following options on the Sites menu may be disabled based on the currently selected view settings: Hide All, Show All, Font, Call Info. Changing the summary view settings may allow use of these options on the RFSS Header.

Site Header

The Site Header shows the following site-level information:

- **Hide/Show**: Allows the channel activity area under the Site Header to be hidden (minimized) or shown (maximized).
- **Site ID**: ID of the site.
- **Site Alias**: Alias of the site.
- **Busy Duration**: Length of time a busy has been active.
- **Active Busies**: Number of active busies on this site.
- **Active Resources**: Number of active resources in this site.
- **Last Activity**: Date and time of the last call activity received by this site.

![Figure 2.14 – Site Header](image)

The Site Header can display icons to indicate both the Site Trunking and Data Mode status if the application receives the appropriate information from the system.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Site Trunking Inactive" /></td>
<td>Site Trunking Inactive – The Site is connected to the network.</td>
</tr>
<tr>
<td><img src="image" alt="Site Trunking Active" /></td>
<td>Site Trunking Active – The Site is disconnected from the network.</td>
</tr>
<tr>
<td><img src="image" alt="Full Data Mode" /></td>
<td>Full Data Mode. For Transit Systems, this mode indicates there are CAD(s) connected to the system.</td>
</tr>
<tr>
<td><img src="image" alt="Reduced Data Mode" /></td>
<td>Reduced Data Mode. For Transit Systems, this is called FallBack Mode and means there are no CAD(s) connected to the system.</td>
</tr>
<tr>
<td><img src="image" alt="Unknown Data Mode" /></td>
<td>Unknown Data Mode. Information on the current data mode is not currently available.</td>
</tr>
</tbody>
</table>
Statistics

Right-clicking on a site or RFSS will open a context menu containing an option to view statistics for completed PTTs. The *QUICK Statistics* window (Figure 2.15) cannot be refreshed and does not update itself as activity is received. It displays a snapshot of known statistics for the moment it was opened.

Notes about statistics:

- Multisite PTTs count as a resource on each site involved. For example, a PTT that involves two sites in an RFSS will count as two resources in that RFSS. RFSS-level statistics display resource counts to more accurately reflect this information. Multisite calls list the sites involved in a call in the *Site ID List* field of the packet.
- Consoles are not included in statistics, even if they are part of a call that also includes sites. Only the sites will be counted.
- For ATIA data, call update packets end the current call and start a new one.
- Interzone activity with a site list is processed normally.
- Calls with elapsed times of zero, such as ATIA calls that time out, will be counted as PTTs/Resources on the *Summary* tab, but will not appear on the *Details* tab.

![QUICK Statistics Window](image)

*Figure 2.15 – QUICK Statistics Window*
The *QUICK Statistics* window is divided into the following three tabs:

- **Summary**: Gives a high-level view of some commonly requested statistics at the channel and site level. Channels are added to statistics when the Channel module is notified of their existence.
  - Channel statistics
    - **Statistics Start Time** – The start time of the statistics for this channel.
    - **Current Time** – The time that the statistics were requested.
    - **Total Available Seconds** – Length of time the channel has been known multiplied by the slot count. For site and RFSS statistics, this will be the time since the first channel was known.
    - **Slots** – Number of slots. The slot(s) for a control channel on a site will be subtracted from this count if the site has generated a *Current Control Channel* packet since the GenWatch service started.
    - **Percent Usage** – Percent of time the channels have been in use since they were known. Calculated by dividing Total Airtime by Total Available Seconds.
  - The following statistics are separated by Voice and Data:
    - **PTT/Resource Count** – Number of PTTs/resources.
    - **Total PTT Seconds** – Total duration of all PTTs.
    - **Total Airtime Seconds** – Sum of the resource times used by all PTTs. A PTT’s resource time is the duration of the PTT multiplied by the number of slots used.
    - **Average PTT Duration** – Average length of a PTT.
  - Site statistics
    - **Statistics Start Time** – The start time of the statistics for this site.
    - **Current Time** – The time that the statistics were requested.
    - **Total Busies/Total Busy Resources** – Number of busies or busy resources.
    - **Average Busy** – Average length of a busy.
    - **Longest Busy** – Longest busy recorded.
- **Details**: Shows a list of the previously mentioned statistics, where values for each are logged every five minutes the GenWatch service is running. PTT/Resource counts reflect the number of PTTs that were active in that interval. If a single PTT spans two intervals, it will count as one PTT in each.
- **Graphs**: Shows a graph of the previously mentioned statistics, charted over time, in five-minute increments.
When opened at the site level, values found in the Channel Statistics section on the Summary tab represent the combined statistics for all channels within the site and values found in the Site Statistics section represent the statistics for the site. When opened at the RFSS level, values found in the Channel Statistics section on the Summary tab represent the combined statistics for all channels within all sites within the RFSS and values found in the Site Statistics section represent the combined statistics for all sites within the RFSS. These statistics are only gathered while the GenWatch service is running. All accumulated statistics are lost and cannot be recovered if the service is restarted.

**Adjacent Sites**

The Adjacent Sites window (Figure 2.16) displays real-time adjacent site information for systems monitored over-the-air. To open this window, right-click on any site and select Adjacent Sites. Note: This option is displayed only when adjacent site information is available.

The monitored site ID is displayed in the top left of the window and each adjacent site is displayed in an informational block. Each adjacent site block contains the adjacent site ID and the current control channel frequency, as well as other properties. The timestamp of the last update is displayed in the bottom right of each block.

![Figure 2.16 – Adjacent Sites Window](image-url)
Site Idle Interval

The site idle interval determines how long the GW_Channel GUI should wait to provide a visual indication that a site is idle (no activity has occurred for x amount of time).

Site idle intervals can be set at the following levels in the hierarchy:

- **Global**: All sites within all systems.
- **System**: All sites within the currently selected system.
- **RFSS**: All sites within the currently selected RFSS.
- **Site**: The currently selected site.

The global site idle interval can be set under the main menu by navigating to **Edit → Global Site Idle Interval**.

Right-clicking on a system, RFSS, or site shown on the right in GW_Channel will provide an option for setting the system-wide, RFSS-wide or site-specific site idle interval, respectively, as shown in Figure 2.17.

![Site Idle Interval option](image)

**Figure 2.17** – Site Idle Interval option

The desired interval can then be entered into the **Idle Interval** window, shown in Figure 2.18.

![Idle Interval Window](image)

**Figure 2.18** – Idle Interval Window

A site’s idle state is indicated via the **Site Header**, which turns solid yellow, as shown in Figure 2.19.

![Site Header](image)

**Figure 2.19** – A yellow site, indicating it is idle
Channel Activity

The channel activity area (Figure 2.20) shows real-time channel-based activity as it occurs.

<table>
<thead>
<tr>
<th>Channel 1</th>
<th>Channel 2</th>
<th>Channel 3</th>
<th>Channel 4</th>
<th>Channel 5</th>
<th>Channel 6</th>
<th>Channel 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTROL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Channel block headers are color-coded to indicate which channels are involved in a call across multiple sites or RFSSs. If a call is being sourced from the site being viewed, the @ symbol will appear on the right in the channel header, as seen in Figure 2.21:

![Figure 2.21 – Channel Header]

The body of each channel block is colored according to the type of activity it is handling and corresponds to the Color Legend. Channels that do not contain any text in the body have not yet received activity.

Radio Commands

The following radio commands are “flashed” on control channel for about two seconds as they occur:

- Selective Inhibit
- Cancel Selective Inhibit
- Request Radio Affiliation
- Call Alert
- Selector Lock
- Selector Unlock
- Dynamic Regrouping
- Ring

After the flash period expires, the channel reverts to showing CONTROL.
**Slotted Activity**

Some radio systems divide their physical channels into two or more logical channels, called *slots*. For example, the P25 radio system can use a multiplexing method known as Time Division Multiple Access (TDMA) to divide a 12.5 kHz frequency into two 6.25-kHz-equivalent slots.

If a channel is divided into slots, this will be represented in GW_Channel by an additional block for each slot. A number to the right of the channel identifier will indicate the slot number, as shown in Figure 2.22.

![Figure 2.22 – Channel Activity on a TDMA-capable site.](image)

When GW_Channel loads a site, it will display slot blocks based on the number of slots specified for the channel in the GW_Alias module. Additional slot blocks will be shown if call activity occurs on those slots. If a channel displaying multiple slots receives activity that spans the entire channel, the channel will be temporarily recombined into one extra-wide channel block, as shown in Figure 2.23 below.

![Figure 2.23 – Diagnostic affecting both slots of a TDMA-capable channel.](image)
Systems with large numbers of channels

Systems with more than 2,000 channels can experience Windows resource issues in the GW_Channel module. If this occurs, GenWatch3 will display an error stating that window handles could not be created.

If this error occurs, you may need to reconfigure the Windows registry to allow more resources. Contact your local IT Department or Genesis Support to modify the following value:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows\USERProcessHandleQuota
```

The default value of 10,000 can be increased to a maximum of 18,000.

Only a system administrator should edit the Windows registry. Microsoft has posted the following warning: Serious problems might occur if you modify the registry incorrectly by using Registry Editor or by using another method. These problems might require that you reinstall the operating system. Microsoft cannot guarantee that these problems can be solved. Modify the registry at your own risk.

**Duplex Activity**

When GW_Channel receives a duplex call, it will display both the channels that the call is using in real time. GW_Channel displays both occupied channels with the call information as seen in Figure 2.24.

![Figure 2.24 – Duplex call shown occupying two active channels.](image)

**Analog and Digital Activity**

The lower-right corner of the channel block will show either an “A” for analog or “D” for digital (Figure 2.25). This icon’s coloration will change based on the security type of the activity: Coded activity will have a blue background and white lettering, while clear activity will have a white background and blue lettering.

![Figure 2.25 – Digital Indicator](image)
Dimetra Channel Capabilities
For customers receiving Dimetra 7.9 or later data, there will be a grid shown on the bottom-left side of each channel block indicating the capabilities of the channel. These capabilities will be represented in the grid as follows:

<table>
<thead>
<tr>
<th></th>
<th>Data</th>
<th>eTetra</th>
<th>Full Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary</td>
<td>Multislot</td>
<td>Physical</td>
<td>Channel</td>
</tr>
<tr>
<td>Control Channel</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

White blocks indicate that the current activity is not of this type. It is possible activity will have zero or more blocks colored. An example can be seen in Figure 2.26.

![Figure 2.26 – Channel block footer with Dimetra 7.9 data coming through.](image)

Dimetra Control Channel Utilization
When the **Show Control Channel Utilization** option is enabled, GW_Channel displays the control channel load percentage contained in Site Monitor Update packets. The control channel load percentage is the percentage of time the control channel was in use within the hardware’s load indicator sampling period (2 minutes). This value is shown in the control channel utilization block in the lower-right corner of the channel block for a Dimetra control channel (Figure 2.27).

The color of the channel utilization block will change based on the percentage load. The thresholds for color changes can be configured with the **High Threshold** and **Mid Threshold** settings in the *Options* menu. See the *GW_Channel Options* section of this document for more information.

![Figure 2.27 – Channel block with a channel utilization block in the footer.](image)
APM Data Supplementation
GW_Channel can display transmit and receive channel information reported from an APM device. (See the GW_Connect Module Book for more information on APM device connections.)

- While the APM reports a channel as transmitting, the transmit level is shown in white text with a green background (see Channel 7 in Figure 2.28).
- While the APM reports a channel as not transmitting, the transmit level is shown in green text with a gray background (see Channel 6 in Figure 2.28).
- While the APM reports a channel as receiving, the receive level is shown in white text with a dark blue background (see Channel 6 in Figure 2.28).
- While the APM reports a channel as not receiving, the receive level is shown in dark blue text with a gray background (see Channel 7 in Figure 2.28).

![Channel 6](image1)

![Channel 7](image2)

![Channel 8](image3)

**Figure 2.28 – APM Data Supplementation**

Channel shows a red alarm bell () on the bottom-left of channels whose last report indicated one or more APM alarms. APM alarms include:

- Antenna Isolation Loss Fail
- Combiner Insertion Loss Fail
- Receive Power Level Fail
- Transmit Power Level Fail
- VCO Lock Fail
- VSWR Fail

Receive values are shown in GW_Channel only if your license includes the ProcessRssiPackets restriction under GW_Channel.
Packet Information Window

It is possible to view additional information about a call or event by double-clicking on any channel that has received activity.

Figure 2.29 – Packet Information Window

The *Packet Information* window provides a list of all information GenWatch3 has about the current (or last known) activity for the channel.

A channel with a control indicator that receives activity will return to displaying the control indicator once that activity ends. Double-clicking the channel will display the information for the last activity received.
Threshold Lights

Threshold lights will flash when GW_Channel receives a message from the GW_Trigger module regarding a threshold that has been reached. Depending upon how the threshold is set up, the red, amber or green light will flash. Only threshold alerts involving groups in the current user’s attachment list will be displayed. Clicking on one of the three lights will open the Threshold Alerts panel (see Figure 2.30).

![Threshold Alerts panel](image)

**Figure 2.30** – Threshold Alert panel without any filtering enabled

Example Thresholds

Threshold triggers are created in GW_Trigger and can be configured to alert users to a wide range of conditions. The following example would alert users to the absence of call activity.

*On the lack of 1 occurrence within 10 minutes of PTT events, trigger this red/amber/green light using the color amber.*

The light color should be used to indicate the severity of a trigger, and since it’s possible for the previous condition to arise within a fully operational site, the amber threshold color has been selected. The next example shows a trigger that causes the red threshold light to flash when more than 5 busies occur in less than 1 minute.

*On the presence of 5 occurrence(s) within 1 minute of Busy events, trigger this red/amber/green light using the color red.*

See the *GW_Trigger Module Book* for information about other triggers, detailed setup options and more examples.
Threshold Alert panel

The Threshold Alerts panel lists all thresholds that have been reached and allows the thresholds to be filtered by color. Color corresponds to severity, where green indicates a normal priority and red indicates the highest priority. Each item listed contains the timestamp of when the threshold was reached and its description. Items will be displayed in bold until acknowledged.

Single-clicking on an item in the list will acknowledge the alert. If a trigger is based upon a threshold event, double-clicking on its threshold alert item in the alert panel will reposition the activity view of GW_Channel to show the site on which the activity was initiated. Alerts of a certain color can be filtered out by turning off the filter lights at the top of the Threshold Alerts panel. Click the X button at the top right of the panel to close it.
Console Window

The Console Window (Figure 2.31) displays console activity separate from the main Channel View. The window is opened by clicking Consoles on the RFSS Header.

![Console Window Screenshot](image)

**Figure 2.31 – Console Window**

Interzone console activity is not shown in this window. Even if you have a multi-RFSS data source, you will see only console activity reported from the local RFSS.

The channel numbers in console windows are arbitrary and indicate how many concurrent console calls have occurred on a console. Because these numbers are assigned in the input module using all types of console calls (interzone and local RFSS) and GW_Channel only shows local RFSS console calls, you may notice gaps in the channel numbers.

**Gold Elite Consoles**

Channel shows Gold Elite-style console activity on Console Site 0. Gold Elite consoles will be the only consoles that set the “Console Active” field in packet details.

For private calls, the Gold Elite console window will only show the console-originated PTTs. The target unit's site will show activity when the unit receives a console PTT and when the unit originates a PTT.

**Vortex Consoles**

Channel shows Vortex-style console activity using the Vortex console ID as the Site.